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2006—Year in Review 

This year brought many changes to STN®, including 

IPC Reform, new releases of STN® AnaVistTM and 

STN Express with Discover!, system and database 

enhancements, and numerous training opportunities. 

This article summarizes notable information about 

STN features, products, databases, and services 

published in STNews in 2006.  Issue and page 

references for all of the 2006 news may be found 

in STNews: An index to the 2006 issues.  The index 

is included with this issue of STNews and is also 

available at www.cas.org.
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In particular, the following enhancements became available in 2006:

•	 STN patent databases were modified to accept IPC codes in either pre-                 
or post-Reform format for searching. This eliminated the need for users to 
reformat the IPC codes in their strategies.  

•	 Cross-field searching capabilities were retained.  It is possible to search a 
pre-Reform IPC code, without reformatting, in the revised IPC field.  It is also 
possible to search an IPC 7 code in an IPC 8 format, without reformatting, in 
the ICM field, which appears only in pre-Reform records. 

•	 The new SET command, SET ICFORMAT ON, allowed users to DISPLAY           
or SELECT pre-Reform IPC codes in the new IPC 8 format. 

•	 Rolled-up Core codes were implemented in a number of STN databases, 
allowing users a means to search across IPC codes assigned by different 
patent-issuing organizations at the Advanced and Core levels.  

•	 A new version of the IPC thesaurus became available in most IPC code-
containing databases on STN. This enhanced searching opportunities  
in these databases, especially those in which the IPC thesaurus was 
implemented for the first time.

•	 Patent family members in the CA/CAplus family of databases were enhanced 
with the addition of available IPC code information for many patent family 
members, including the backfile, providing additional retrieval opportunities 
for patent documents included in CA/CAplus.

•	 A number of IPC code-containing patent databases on STN were also 
enhanced with IPC reclassification data in the new IPC Reclassification  
(IPCR) field. 

Progress on the details of IPC Reform implementation in STN databases        
was provided throughout 2006 at  www.cas.org/EO/ipcreform.html.

For information on specific databases, see the Database Enhancements section 
later in this article. 

Enhanced access to IPC 8 data
On January 1, 2006, the World Intellectual 
Property Organization’s (WIPO) 
International Patent Classification (IPC) 
Reform went into effect for patent-issuing 
authorities using IPC codes.  IPC Reform 
codes, commonly referred to as IPC 
8 codes, post-Reform codes, or IPC 
symbols, enhance search and retrieval 
efforts and efficiency through this new 
standard classification index. 

IPC 8 codes began to be included in STN 
patent databases starting in January 2006.  
In tandem with the reform efforts, the 
European Patent Office (EPO) reclassified 
patents to conform to the IPC Reform.  
Reclassifications were also added to 
several STN patent databases—most 
notably, the CASM/CAplusSM family 
of databases, USPATFULL/USPAT2, 
and INPADOC.  A second round of 
reclassifications delivered late in the year 
was released in the CA/CAplus family of 
databases and in USPATFULL/USPAT2.

STN actively implemented IPC 8 data 
into its patent databases.  The STN 
implementation provided access to new 
additional information provided with IPC 
8, enabled file crossovers, and provided 
multifile searching capabilities. 
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STN AnaVist—feature enhancements
STN AnaVist, the analysis and visualization software introduced 
by STN in 2005, was further developed and enhanced in 2006. 
Pricing for STN AnaVist was simplified, the ability to create subset 
visualizations at no additional charge proved to be a key benefit 
and was very popular among STN AnaVist users, and a policy 
of not charging for the STN AnaVist software also was adopted. 

A new release of the software also introduced two major features: 

•	 Sharing visualization projects

•	 Creating project reports 

Sharing visualization projects

Visualization projects can now be shared if both the sender 
and receiver have:

•	 STN AnaVist, Version 1.1

•	 A full-access STN login ID or STN AnaVist Login ID                   
for Shared Projects

Login IDs for Shared Projects allow the holder to:

•	 Download or order STN AnaVist software

•	 Open STN AnaVist shared projects

•	 Customize projects, e.g., create new charts, edit terms

•	 Display, print, and save documents (standard charges apply)

•	 Perform subset visualizations

STN AnaVist Login IDs for Shared Projects must be requested 
by a full-access STN login ID holder.  All fees incurred by the 
STN AnaVist Login ID for Shared Projects holder are billed to the 
full-access STN account with which they are associated.

	 The shared project is saved in AnaVist eXchange 		
	 format (.avx) as a small file (less than 10 KB) that 		
	 can be easily stored or sent by e-mail.

The recipient of the .avx file can open the project by either 
double-clicking on the file or selecting File > Open Project Copy 
within STN AnaVist.

Creating project reports

	 Two types of predefined reports 
	 can be created as either .rtf or .pdf 		
	 documents:
  

	 •	 One-page Summary Reports 

	 •	 Multiple-page Detailed Reports 

     
Summary Reports are one-page overviews that include: 

•	 Information about the project, e.g., creation date, number of 
documents

•	 Charts of publication trends, top organizations, and top authors/
inventors

•	 Research Landscape 

•	 Short list of selected documents from the project

Sample summary and 
detailed reports from STN 
AnaVist.  These predefined 
reports can be created 
quickly and easily for any 
visualization project.
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STN system enhancements 

LOGOFF HOLD duration extended 

The time limit set for the LOGOFF HOLD command in STN 
has been extended from 60 to 120 minutes.  

E-mail format enhanced 

The PRINT command in STN lets you send prints (copies) 
of answers electronically to a specified STNmail ID 
or e-mail address.  

The format for e-mail generated with the PRINT command 
now includes additional information.

The format for hyperlinked e-mail generated with the 
SDI command now includes additional information.

CAS Registry Number crossover limit increased 
to 300,000 in multiple databases
 
The crossover limit for CAS Registry Numbers (RN) 
has increased in 17 additional databases on STN.

More detail regarding the enhancements listed here 
is available in the Take Note section of this issue.

Detailed Reports are multiple-page documents that contain:

•	 Summary of the project, e.g., databases and types of 
documents searched, total number of documents, overall 
publication trends

•	 Research Landscape

•	 Top organizations, including publication trends

•	 Collaboration charts, indicating documents that were co-
authored by researchers at more than one organization

•	 Top researchers, including numbers of documents

•	 List of selected documents from the project

STN Express with Discover!— 
feature enhancements 

Three free maintenance releases for STN Express with Discover! 
became available during 2006.  These releases provided 
a number of customer-requested enhancements.

The following feature enhancements were introduced: 

•	 STN Express® now launches automatically when you        
double-click any of these file types: .rep, .tbl, .str, .trn. 

•	 Selecting Help > View STN Express User Guide provides 
access to the most recent updates in the STN Express User 
Guide.

•	 The Report and Table post-processing tools have been      
updated to accommodate new fields available in the recently 
reloaded Derwent World Patents Index (DWPISM) database   
suite.  

STN AnaVist, the analysis and visualization 
software introduced by STN in 2005, was further 

developed and enhanced in 2006. 
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Database enhancements

ADISCTI

The database was reloaded and enhanced 
with new search and display fields: 
Ongoing Trial (OT), Classification Code 
(CC), Other Source (OS), Data Entry Date 
(DED), Data Update Date (DUP), and ISSN 
Number (ISN).

Simultaneous left and right truncation 
(SLART) became available in Basic Index 
(BI) and Title (TI) fields, and the stop word 
list was removed.  

BEILSTEIN 

The database was updated with more 
than 64,000 new compounds and 
supplementary data for approximately 
40,300 compounds.   

BIOSIS®

Journal coverage was expanded to include 
additional 250 journal titles representing all 
areas of life sciences.  

CASM/CAplusSM

The following enhancements and additions 
took place as a result of the implementation 
of the IPC Reform:
 
•	 IPC 8 codes and reclassifications from 

the European Patent Office (EPO) were 
added.  

•	 IPC codes for many patent family 
members were added. 

•	 IPC range searching was enhanced by 
allowing spaces around a hyphen when 
searching an IPC range, in addition to 
being able to use a colon, with or without 
spaces.  

•	 The IPC thesaurus was enhanced by 
identifying the Core and Advanced IPC 
codes. 

•	 Arrow highlighting was added to the IPC.
TAB display format.  

•	 Rolled-up Core codes were added.

Many patent kind codes used in CA/CAplus 
records were changed so that they more 
accurately represent the data published 
on the patent documents. The backfile was 
updated with the new patent kind codes to 
ensure searching consistency. The PK.OLD 
and PK.B.OLD fields were introduced to 
contain the patent kind code information 
that was previously used. 
 
The F-Term thesaurus for patent 
classifications used by the Japanese Patent 
Office (JPO) was enhanced to provide 
better hierarchical displays and searching 
capabilities. 
 
The Company Name Thesaurus was 
updated and now includes over 100,000 
names.

Austrian patent law changes were 
accommodated so that patent applications 
continue to be covered in CA/CAplus as 
basic patents, i.e., the first family member 
of a family added to CA/CAplus.  Granted 
patents are covered as family members.
 
Simultaneous left and right truncation 
(SLART) was added to the individual 
fields that comprise the Basic Index (BI), 
including Abstract (AB), Title (TI), Index 
Term (IT), and Supplementary Term (ST) 
fields.

The display of indexing terms for general 
subject terms in the CA Lexicon was 
enhanced.  All OLD terms are now 
displayed together at the beginning of 
the +ALL/CT display.  In addition, the new 
+MAX relationship code can be used 
in place of +ALL, LT to display linking 
terms, i.e., terms that modify the controlled 
vocabulary subject index headings.

More pre-1907 records were added.  Over 
18,000 records for U.S. chemical patents 
from 1900-1906 were added.  In addition, 
over 2,600 records from the 1878-1906 
issues of the Journal of the Chemical 
Society, Transactions were added.

The CAS preparation role (PREP) was 
added to nearly 4 million index entries 
in CA/CAplus records from 1907-1966.  
Simplified retrieval of preparations will be 
possible from 1907 to the present.

The CA/CAplus to MARPAT® accession 
number (AN) crossover limit was increased 
from 10,000 to 50,000.

CEABA-VTB

The English (CC) and German (CCDE) 
classification code fields in CEABA-VTB 
were reloaded with a new classification 
scheme.

CHEMCATS® 

The total number of records surpassed 
12 million.  

CHEMLIST®

The new Restricted Chemical List (RSTR) 
search and display field identifies chemical 
substances that have legislative import, 
manufacture, and/or use restrictions in the 
following countries: Israel, Taiwan, Canada, 
Hong Kong, Singapore, India, Pakistan, 
and China.  

CHEMSAFE

Recommended safety characteristics of 
approximately 2,800 pure components 
and 500 mixtures (e.g., flammable liquids, 
gases, and dusts) were added.  

EMBASE/EMBAL 

New data for the Electronic ISSN  
(E-ISSN) and Article Number (ARN) were 
added to the Source (SO) field.  E-ISSN 
data were also added to the International 
Standard (ISN) field for search and display. 
 
EMBASE began daily, rather than a weekly, 
updates.  Current-awareness alert (SDI) 
frequencies remain weekly (default) and 
biweekly.

ENCOMPLIT/ENCOMPLIT2 

New data for the Electronic ISSN (E-ISSN) 
and Article Number (ARN) were added to 
the Source (SO) field.  E-ISSN data were 
also added to the International Standard 
(ISN) field for search and display. 
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EPFULL

IPC 8 Reform codes and the IPC thesaurus 
were implemented. 

FRANCEPAT

Updates were resumed and are now 
being implemented on a weekly basis.
  
IPC 8 codes were added, and the IPC 
thesaurus was implemented.  

FSTATM

Coverage was enhanced to include 
Japanese patent documents.

IFIPAT/IFIUDB/IFICDB

A reload was launched late in 2006. 
Key features were the implementation 
of IPC Reform, the introduction of an 
IPC thesaurus, separately searchable 
Abstract and Claims fields, the removal 
of stopwords, and the availability of 
simultaneous left and right truncation 
(SLART) in a number of Basic Index 
fields.  

INPADOC

IPC 8 codes and reclassified IPC codes 
were implemented. 

Rolled-up Core IPC codes were added 
for searching and displaying.
 
The IPC thesaurus was implemented.  

  
INSPEC® 

The 1898-1968 Archive enhancement 
resulted in the addition of 873,699 records.
 
More granular search fields for the abstract 
and controlled terms are now available.

JAPIO

JAPIO was enhanced with IPC 8-compliant 
features and functionality.  A number of 
new search, display, and select fields and 
an IPC thesaurus were added.

 
MARPAT 

Approximately 48,000 Markush structures 
were added from the pre-1988 time period.
 
Structure highlighting in the FQHIT and 
QHIT display formats was improved.  In 
addition, the option to SET MARHIGHLIGHT 
OFF was added to allow you to revert to 
the original FQHIT and QHIT highlighting. 

 
MEDLINE®/LMEDLINE 

The annual reload was launched early 
in the year.
 
2006 MeSH terms became available.  
Over 990 new MeSH Headings and more 
than 185 updated MeSH Headings were 
added to reflect more current terminology. 
 
The following enhancements were 
also made:
 
•	 Electronic ISSN (E-ISSN) for electronic 

journals were added, when available, to 
the Source (SO) field.  

•	 Stop words were eliminated. 

•	 A new search and display field, 
COMMENT (CM), was added. 

•	 At least one MeSH heading in the 
Controlled Term (CT) was added            
to OLDMEDLINE records. 

•	 Simultaneous left and right truncation 
(SLART) was added to the Title (TI)       
field. 

•	 Publication Date (PD) was made a 
numeric field in the YYYYMMDD format 
that is searchable and selectable.

•	 Publication dates were made searchable 
in the SO field but not in the numeric 
YYYYMMDD format.  

PATDPAFULL 

IPC 8 codes were added, and the 
IPC thesaurus was implemented.  

PATDPASPC
 
IPC 8 codes were added, and the 
IPC thesaurus was implemented.  

PAPERCHEM2 

New data for the Electronic ISSN (E-ISSN) 
and Article Number (ARN) were added 
to the Source (SO) field.  E-ISSN data were 
also added to the International Standard 
(ISN) field for search and display.
  
IPC codes were made to be searchable 
in both pre- and post-Reform format.
  
PCTFULL
 
U.S. inventor names are no longer indexed 
in the Patent Assignee (PA) field, but rather 
in the Inventor (IN) field.
 
IPC 8 codes were added, and the IPC 
thesaurus was implemented. 

 
REGISTRY/ZREGISTRY

Nearly 40,000 mass spectral images 
were added to over 30,000 records.

With this enhancement, MASS/SPEC 
and MASS SPECTRA/SPEC were added 
to the search fields, and SPEC.MASS 
to the display fields.

The amino acid codes for pyrrolysine 
were added. 
 
The CAS Registry Number crossover limit 
increased to 300,000 in multiple databases 
on STN.

RUSSIAPAT

The IPC thesaurus was implemented. 
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TOXCENTERSM

2006 MeSH headings and tree number 
terms were made available in all new 
records and updated records for the 
MEDLINE segment of TOXCENTER.

The following enhancements were made:

•	 All labels of subfields in the Source (SO) 
field are now searchable.

•	 Former stop words are now indexed.

•	 Simultaneous left and right truncation 
(SLART) was added to the Title (TI) field.

The following enhancements were made to 
the MEDLINE segment of TOXCENTER:

•	 The Source (SO) field now contains the 
International Standard Serial Number 
(ISSN) for print and the Electronic ISSN 
(E-ISSN) for electronic journals when 
available.

•	 OLDMEDLINE records now include at 
least one MeSH heading in the Controlled 
Term (CT) field.

•	 A new search and display field, 
COMMENT (CM), is now available            
and displays after the SO field in the       
ALL format. 

 
TULSA/TULSA2

IPC Reform features were added and 
an IPC thesaurus was implemented.
 
Simultaneous left and right truncation 
(SLART) was added in the Abstract (AB), 
Basic Index (BI), and Title (TI) fields, and 
sentence proximity searching was added 
in the AB field.

Over 140,000 records in the TULSA 
database backfile were enhanced with 
the addition of abstracts. 

A new monthly current-awareness alert 
(SDI) frequency became available; SDIs 
are now available both weekly (default) 
and monthly. 

USPATFULL/USPAT2 

The following enhancements and additions 
took place as a result of the implementation 
of IPC Reform:

•	 IPC 8 codes and the European Patent 
Office (EPO) reclassifications were 
added.

 •	IPC code range searching was enhanced 
by allowing a hyphen with spaces, in 
addition to being able to use a colon, 
with or without spaces, between the 
codes in your search. 

•	 Arrow highlighting was added to the IPC.
TAB display format.

  •	The IPC thesaurus was enhanced by 
identifying the Core and Advanced IPC 
codes. 

 •	Rolled-up Core codes were added to the 
International Patent Initial Classification 
(IPCI) field. 

 
WPIFV/WPIDS/WPINDEX/WPIX 

A complete reload offered many new 
and enhanced features:
 
•	 New record structure for the Invention 

Level (or patent family) comprising the 
traditional Derwent content and the 
Member Patent Level (or publication) 
now allows users to search and display 
bibliographic data and general indexing 
information associated with individual 
documents that make up the patent 
family Invention Level.

•	 Text-searchable archival abstracts 
indexed in the Basic Index enhance 
retrieval.

•	 Additional first-level data were added.

•	 IPC Reform enhancements were 
implemented.

•	 New search options were made 
available, e.g., USPTO national patent 
classifications, more search fields with 
simultaneous left and right truncation 
(SLART), stop words removal.

•	 Enhanced display and download options 
were added.

Changes to the Austrian patent law 
were implemented.
 
Manual codes were revised and 
incorporated. 

Starting with update 200638, coverage 
of the defensive publication journal 
Research Disclosure was reinstated 
and the missing backfile was added.  
The database now has full coverage of 
Research Disclosure from October 1978 
to the present. 
 
A new application number format for 
Chinese (CN) patents was implemented. 

Training opportunities
CAS e-Seminars, web-based seminars, 
bring professional training to your 
desktop.  In 2006, the following e-
Seminars were offered:

•	 Finding Antibodies & Immunoglobulins

•	 Is that patent still valid?  Finding patent 
expirations and extensions

•	 Finding Regulatory Compliance 
Information in CHEMLIST

•	 Property Searching in CAS REGISTRY 

•	 Searching for Engineering Information

•	 Using Discover! Wizards                             
in STN Express

•	 Capitalizing on IPC Reform

•	 Creating Superior Document Sets            
for STN AnaVist

•	 Maximizing your STN Fixed Fee Plan

•	 Text Searching in CAS REGISTRY

•	 STN: Multifile Structure Searching             
for Patent Information

•	 STN: Processing Sequence Data

To view a recording, visit 
https://casevents.webex.com.
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CA/CAplus
−F-Term thesaurus enhanced; patent kind codes updated; 
pre-1967 chemical substance index entries enhanced 
with preparation role; MARPAT accession number crossover 
limit increased to 50,000

F-Term thesaurus enhanced
 
The F-Term thesaurus in CA/CAplus has been enhanced with 
multilevel Narrower Terms (NT) in the search and display hierarchy.

The F-Term thesaurus was added to CA/CAplus earlier this year 
to provide enhanced and efficient access to Japanese patent 
content.  F-Terms are patent classifications used by the Japanese 
Patent Office (JPO) and have been included in CA/CAplus 
since January 2004. 

Patent kind codes updated

Patent kind codes in CA/CAplus records are being updated 
to more accurately reflect data published on patent documents.  
As a result, patent kind codes in many new CA/CAplus records 
are expected to change.  To ensure consistent patent kind 
code searching, updating of the CA/CAplus backfile will begin 
in late December. 
 
The updated patent kind codes appear in the PK and PK.B fields 
of CA/CAplus.  New PK.OLD and PK.B.OLD fields display the 
old patent kind codes.  These new fields are not included in any 
default display formats, but can be added to custom displays.
 
The update to CA/CAplus patent kind codes may impact 
search strategies in current-awareness alerts (SDIs) or in saved 
search queries.  You are encouraged to confirm the validity 
of these queries.
 
Information on the updated patent kind codes is available at:
www.cas.org/EO/patkindchanges.html  
 
Additional information on patent kind codes in CA/CAplus 
is available at:
www.cas.org/EO/patkind.html 
www.cas.org/EO/patyear.html 

Pre-1967 chemical substance index entries enhanced 
with preparation role
 
The CAS preparation role (PREP) has been added to nearly 
4 million index entries in CA/CAplus records from 1907-1966.  
Simplified retrieval of preparations is now possible from the 
beginning of CA indexing in 1907 to the present.
 
Additional information on CAS roles is available at:
www.cas.org/ONLINE/QR/casroles.pdf 

MARPAT accession number crossover limit increased to 50,000

The CA/CAplus to MARPAT accession number (AN) crossover limit 
has increased from 10,000 to 50,000.

The CA/CAplus Database Summary Sheets are available at:  
www.cas.org/ONLINE/DBSS/cass.html
www.cas.org/ONLINE/DBSS/caplusss.html

CHEMLIST
−enhanced with new search and display field

A Restricted Chemical List (RSTR) search and display field 
is now available in CHEMLIST.  The RSTR field identifies chemical 
substances that have legislative import, manufacture, and/or use 
restrictions in Israel, Taiwan, Canada, Hong Kong, Singapore, 
India, Pakistan, and China.  Restricted chemical lists from 
additional countries will be added as they are identified.

The CHEMLIST Database Summary Sheet is available at:  
www.cas.org/ONLINE/DBSS/chemlistss.html

JAPIO
Japan Patent Information Organization
−enhanced with IPC 8 features and functionality

The Japan Patent Information Organization database (JAPIO) 
is now ICP 8 compliant.  A number of new search, display, 
and select fields and an IPC thesaurus have been added 
to the database.  

The May 2006 monthly update is now available in JAPIO.  
Additional monthly updates will be completed in the coming 
weeks until the database is up-to-date.  SDIs will be processed 
as the monthly updates are loaded.

Enter HELP CHANGE in JAPIO for details on the IPC 8 
enhancements. 

Additional information on IPC Reform is available at:
www.stn-international.de/stndatabases/details/ipc_reform.html

The JAPIO Database Summary Sheet is available at:  
www.cas.org/ONLINE/DBSS/japioss.html
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CAS contacts 

CAS Customer Care: 	 Phone: 800-753-4227 (North America) 	
	 or 614-447-3700 (worldwide)

CAS:	 Phone: 800-848-6538 (North America) 	
	 or 614-447-3600 (worldwide)

E-mail:  	 help@cas.org

CAS web page:	 www.cas.org

STN web page:  	 www.cas.org/stn.html

Information	 www.cas.org/infopro/	
Professionals:	

Patent Information	 www.cas.org/patents/
on STN:	

STNews: 	 www.cas.org/STNEWS/stnewscover.html

STNews back issues: 	 www.cas.org/STNEWS/backissue.html

MARPAT
−option to turn off highlighting enhancements available

Enhanced structure highlighting in the FQHIT and QHIT display 
formats in MARPAT can now be turned off with the SET command.  

•	 SET MARHIGHLIGHT OFF displays the original FQHIT and QHIT 
display formats in MARPAT.

•	 SET MARHIGHLIGHT ON is the default setting and displays all 
current MARPAT highlighting features.  

In order for SET MARHIGHLIGHT ON to display all current 
highlighting features, the systemwide SET HIGHLIGHT ON 
command must also be in effect.

The MARPAT Database Summary Sheet is available at:  
www.cas.org/ONLINE/DBSS/marpatss.html

Derwent World Patents Index
−include the new DWPI Manual Codes in your 2007 searches 
and alerts

The Manual Code revision in Derwent World Patents Index 
is now complete for 2007, and you will start to see the new and 
revised codes with the first update of January 2007.  To ensure 
that you do not miss out on important data about the latest global 
technology developments, please check your searches and alerts 
to ensure they include any relevant new codes or any changes 
to existing codes.

To view the full lists of new, revised, and retired codes for both 
CPI and EPI, please go to:
scientific.thomson.com/dwpi-manualcoderevision/

STNews
STNews is written and produced cooperatively by Chemical 
Abstracts Service and FIZ Karlsruhe, and printed in three separate 
editions.

Staff, North American 
Edition:   
Editor:  Crystal Poole

FIZ Karlsruhe
Dr. Gerhard Herlan

For the North American Edition © 2006 American Chemical Society. 
Quoting or republishing of material from STNews is encouraged 
provided that acknowledgement is made of STNews  as the source. 
CAS requests that a copy of the reproduced material be sent to 
CAS Customer Care, P.O. Box 3012, Columbus, OH 43210-0012 
U.S.A. Please send all address changes to CAS, P.O. Box 3012,  
Columbus, OH 43210-0012 U.S.A. E-mail us at help@cas.org.

Contributing
Editors:
Jim Blake
Peter Carlton
Elizabeth Haines

Design/Production: 
Pat Farnlacher
Nadine Mosley
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Enhancements to Derwent World Patents Index

In October, an enhanced version of 
Derwent World Patents Index (DWPI) 
was made available on STN.  The DWPI 
database is available in WPINDEX, WPIDS, 
and WPIX. 

Details about the reload were included 
in the Database News section of the 
September/October issus of STNews.  
This article highlights the enhancements 
and provides a sample record. 

The DWPI database offers patent 
information searchers a broader 
view of global patenting activity. The 
enhancements provide new value-added 
content and original patent data, as well 
as a new two-part structure to facilitate 
access to the vast data contained 
in DWPI. 

“STN customers will greatly benefit from 
the additional content and the new record 
structure, enabling even more precise 
searching and thus giving them greater 
insight into their areas of specific interest,” 
said Dr. Rainer Stuike-Prill, vice president 
Marketing and Sales, FIZ Karlsruhe.

Additional content

New information that is available through 
the enhanced DWPI database includes:

•	 Over 750,000 Documentation Abstracts 
(1995-1999)

•	 Additional chemical structure indexing 
(Chemistry Resource) backfile

•	 New first-level data, such as original 
patent titles and abstracts, full names 
of inventors and associated addresses, 
and patent agent information

•	 Coverage of USPTO national patent    
data classifications

An enhanced DWPI database record.

L2   ANSWER 1 OF 1   WPIX  COPYRIGHT 2006 THE THOMSON CORP 
on STN 

ACCESSION NUMBER:    2000-430976 [37]   WPIX
TITLE:               Self-healing roll for surface 
                     conditioning of sheets, e.g. metal 
                     sheets, has non-woven web elements 
                     comprising entangled fibers held 
                     together by a bonding agent
DERWENT CLASS:       A88; F04; M12; P51; P73; Q62
INVENTOR(S):         BARBER L L; YOUNG J B
PATENT ASSIGNEE(S):  (MINN-C) 3M INNOVATIVE PROPERTIES CO

PATENT INFORMATION:

PATENT NO     KIND DATE    WEEK     LA  PG    MAIN IPC
-----------------------------------------------------
WO 2000030778 A1 20000602 (200037)* EN  25[3] B21B045-02
EP 1135220    A1 20010926 (200157)  EN        B21B045-02
US 6300261    B1 20011009 (200162)  EN        D04H001-00
EP 1135220    B1 20020904 (200266)  EN        21B045-02
DE 69902811   E  20021010 (200274)  DE	
JP 2002530544 W  20020917 (200276)  JA  24    D04H001-58
					    .
					    .
					    .

GRAPHIC INFORMATION:

BASIC ABSTRACT: 
WO 2000030778 A1
       NOVELTY - A self-healing article e.g. in the form of 
roll (21) comprises several compacted stacked web elements 
(22) having entangled fibers bonded together at points of 
mutual contact by a bonding agent. The article is resistant 
to an oxidizing agent and has a Shore A hardness of 70-93 
and a void volume of 2-30%.
       DETAILED DESCRIPTION - An INDEPENDENT CLAIM is also 
included for a method of making a self-healing and non-
woven article comprising (i) providing several non-woven 
web elements comprising entangled fibers bonded at points 
of mutual contact by a bonding agent; (ii) stacking into a 
pile; (iii) compacting under a compaction force; and (iv) 
restraining the pile to form the self-healing article.

Language 
indicators 
for all family 
members.

Separately 
searchable 
DWPI 
abstract 
sections.
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New record structure

A new record structure was also 
introduced.  Two levels of data—
Invention and Members—are available 
for each record.  

The Invention Level comprises 
traditional DWPI content, such as 
patent family and enhanced abstracts. 

The Members Level portion of the 
patent record provides additional 
information from each of the 
publications listed in the patent family. 

This new structure is designed to 
make records easier to access and 
use.

Other enhancements

Several other enhancements were 
made to DWPI, including:

•	 Stop words were removed. 

•	 Simultaneous left and right 
truncation (SLART) is now available 
in most text fields. 

•	 The new subsections on each 
patent family member can now be 
individually searched—providing a 
wealth of additional opportunities for 
more selective searches.

        USE - For surface conditioning of sheets, e.g.  
metal sheets.
        ADVANTAGE - The invention provides a self-healing 
article resistant to oxidizing agents having an increased 
life span. If used, results in fewer roll replacements and 
unscheduled production line downtimes. Chances of chemical 
contamination between treating solutions are also minimized.
        DESCRIPTION OF DRAWINGS - The figure shows a partial 
cross-sectional view of a roll disposed on a keyed shaft. 
Roll (21)
	 Compacted stacked non-woven web elements (22)
					    .
					    .
					    .

INDEX TERMS:    129411-DIS; 140524-DIS; 368-DIS; 395-DIS; 
478-DIS

 
Member(0001)
PI	 WO 2000030778   A1 20000602 (200037)* EN  25[3]     

B21B-45/02
TIEN	SELF-HEALING ARTICLES RESISTANT TO OXIDIZING AGENTS
TIFR	ARTICLES DE REGENERATION RESISTANT AUX AGENTS 

D’OXYDATION
AG	 BUSSE, Paul, W. 3M Innovative Properties Company, Office 

of Intellectual Property Counsel, P.O. Box 33427, Saint 
Paul, MN 55133-3427, US

IN	 YOUNG J B
       INO: YOUNG, John, B.
       INA: P.O. Box 33427, Saint Paul, MN 55133-3427, US
		     BARBER L L
       INO: BARBER, Loren, L.
       INA: P.O. Box 33427, Saint Paul, MN 55133-3427, US
PA	 (MINN-C) 3M INNOVATIVE PROPERTIES CO
	 PAO: 3M INNOVATIVE PROPERTIES COMPANY
  	 PAA: 3M Center, P.O. Box 33427, Saint Paul, 		

	    MN 55133-3427, US
    	Residence: US
  	 Nationality: US
ADT	 WO 2000030778 A1 WO 1999-US24138 19991014
PRAI	US 1998-197132      19981120
IC	 ICM  B21B045-02
  	 ICS  B32B003-08; B32B005-26; B32B031-10; B32B033-00; 	

	    C23G003-02; D04H013-00; F16C013-00
ABEN	Self-healing articles resistant to oxidizing agents 

and useful for surface conditioning of sheets, 
especially metal sheets, are described. The articles 
(21) comprise a plurality of compacted, stacked non-
woven web elements (2, 22), the web elements each 
comprising entangled fibers bonded together at points 
of mutual contact by a bonding agent. The article is 
resistant to an oxidizing agent or agents, has a Shore 
A hardness in the range of 70 to 93 and a void volume 
in the range of 2 to 30 percent. The non-woven articles 
can be configured into any of a variety of convenient 
and useful shapes, such as roll shapes, slab or bar 
shapes. The methods of making these articles are also 
described. 

					    .
					    .
					    .

Enhanced 
chemical 
structure 
backfile.

Agent 
details and 
full inventor 
names.

Searchable 
publication 
level 
bibliographic 
details.

Original titles 
and abstracts.
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Additional resources

For detailed information about recent 
enhancements and reload information, 
visit:
www.stn-international.de/stndatabases/ 
details/dwpi_r.html

The WPINDEX/WPIDS/WPIX Database 
Summary Sheets are available at:
www.cas.org/ONLINE/DBSS/ 
wpindexss.html
www.cas.org/ONLINE/DBSS/wpidsss.html
www.cas.org/ONLINE/DBSS/wpixss.html

The DWPI database offers patent information searchers a broader view of global patenting activity.

Member(0003)
PI	 US 6300261      B1 20011009 (200162)  EN  D04H-1/00
TIEN	 Self-healing articles resistant to oxidizing agents.
AG	 AG.TOT   Allen; Gregory D.
IN	 YOUNG J B
    	 INO: Young, John B.
     	INA: Woodbury, MN, US
		      BARBER L L
    	 INO: Barber, Loren L.
     	INA: Lake Elmo, MN, US
PA	 -
   	 PAO: 3M Innovative Properties Company
    	 PAA: Saint Paul, MN, US
ADT	 US 6300261 B1 US 1998-197132 19981120
IC	 ICM  D04H001-00
IIC	 IICM D04H001-00
INCL	 INCLM 442/328.000
	 INCLS 442/329.000; 442/337.000; 442/417.000; 

428/912.000
ABEN	 Self-healing articles resistant to oxidizing agents 

and useful for surface conditioning of sheets, 
especially metal sheets, are described. The articles 
comprise a plurality of compacted, stacked non-
woven web elements, the web elements each comprising 
entangled fibers bonded together at points of mutual 
contact by a bonding agent. The article is resistant 
to an oxidizing agent or agents, has a Shore A 
hardness in the range of 70 to 93 and a void volume 
in the range of 2 to 30 percent. The non-woven 
articles can be configured into any of a variety of 
convenient and useful shapes, such as roll shapes, 
slab or bar shapes. The methods of making these 
articles are also described. 

CLMEN	A self-healing article suited for use in the surface 
conditioning of sheets, the article comprising: a 
plurality of stacked, compacted web elements, the 
web elements comprising entangled fibers bonded 
together at points of mutual contact by a bonding 
agent comprising material selected from the group 
consisting of polychloroprene, styrene butadiene 
rubber, polysulfide, silicone, polyepichlorohydrin, 
and combinations thereof, wherein the article is 
resistant to an oxidizing agent and has a Shore A 
hardness in the range of 70 to 93 and a void volume 
in the range of 2 to 30 percent.

USPTO Patent 
Classifications.

Original 
patent main 

claim text.
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1.	 Draw your structure with the desired 	
	 double bond stereochemistry.

2.	 Highlight the double bond.

3.	 Select QueryDef > Stereochemistry…

Structure searching for double bond stereochemistry

Q.	 How can I search for double 	
bond stereochemistry?

A.	 By default, REGISTRY 
retrieves structures 
with specific double 
bond stereochemistry 
as well as structures for 
which no double bond 
stereochemistry  
is indicated.  

However, there may be times when you 
want to search for specific double bond 
stereochemistry.  This article describes 
how to construct your search query.

Building your query  
The structure may be drawn by using STN Express with Discover! or STN® on the WebTM.

First, draw your query in the usual way, but be sure that you draw the double bonds 
in a way that shows the stereochemistry you are seeking.  It is not necessary to label 
the double bond stereochemistry.

Second, select the highlighting button 
from the left-hand toolbar and highlight 
the double bond(s) 

Next, from the main menu, select QueryDef > Stereochemistry… 

Under Geometric Bonds, select Stereo and click OK.

Finally, save your query and upload it to REGISTRY.

Create a structure query with stereo-chemistry specified at a double bond. 
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Search the query and display answers.

=> FILE REGISTRY

L1     STRUCTURE UPLOADED
				      .
				      .
				      .

=> S L1 FUL
FULL SEARCH INITIATED 10:13:58
FULL SCREEN SEARCH COMPLETED -     9647 TO ITERATE

100.0% PROCESSED     9647 ITERATIONS          
187 ANSWERS
SEARCH TIME: 00.00.01

L3          187 SEA SSS FUL L1

=> D SCAN STR
   
L3   187 ANSWERS   REGISTRY  COPYRIGHT 2006 ACS on STN 
  
Double bond geometry as shown.

Searching and displaying

First, display your query and run a SAMPLE 
search to verify that the query is correct.

Then, run the full search for your query.  
Look at some answers with the no-fee 
display option, D SCAN.

Notice that this query, with stereochemistry 
specified, retrieves 187 answers.  A similar 
query without stereochemistry specified 
retrieves 668 answers.

Using double bond descriptors

In REGISTRY, double bond stereochemistry 
is described by using E and Z descriptors.  
The assignment is based on priority rules, 
so answers with both E stereochemistry 
and Z stereochemistry are retrieved, but all 
will fit the stereochemistry of your query.

Additional resources 

For more information, see:

Blackwood, James E., et al. J. Am. Chem. 
Soc. 1968, 90 (2), 509-510.

Using Stereosearch on STN Quick 
Reference Card, available at: 
www.cas.org/ONLINE/QR/stereoex.pdf

4.	 Under Geometric Bonds, select 		
	 Stereo.  Click OK. 

5.	 Save your query.
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Enter HELP DIRECTORY or ? DIRECTORY at an arrow prompt (=>).

=> FILE CASREACT
=> ? DIRECTORY

The following HELP messages are available to obtain information 
on the CASREACT File:

 HELP ACCESSION    - CASREACT File accession number formats
 HELP CACROSSOVER  - crossover searching for the CASREACT and CA 

                 files
 HELP COLLECTIVES  - CA Collectives and dates
 HELP CONTENT      - general description of the CASREACT File
 HELP COST         - price schedule for the CASREACT File
 HELP COUNTRY      - patent countries covered by CAS
 HELP CROSSOVER    - file crossover searching for the CASREACT  

                File
 HELP DESK         - information on CASREACT File user assistance
 HELP DFIELDS      - list of display field codes
 HELP DIAGRAM      - structure diagrams
 HELP DSCAN        - list of display fields shown in DISPLAY SCAN
 HELP EFIELDS      - list of extraction field codes in CASREACT
 HELP FGA          - alphabetical list of the functional groups
                      searchable in the CASREACT File
 HELP FGC          - alphabetical list of functional group 

                 classes
 HELP FORMAT       - predefined formats for DISPLAY and PRINT
 HELP HIGHLIGHT    - highlighting information for the CASREACT  

                 File
 HELP (L)          - use of the (L) operator in the CASREACT File
 					       .
					       .
					       .

 For a list of more general help topics such as command usage, 
 enter HELP MESSAGES at an arrow prompt (=>).

For example, here is the database-specific message for HELP YIELD in CASREACT.

=> ? YIELD

 	 The (A) operator is used in the CASREACT File to search for a
 	 desired yield for a reaction product.  To search for a 75-85% yield 

of a product with the CAS Registry Number = 103225-99-6, enter the  
following at an arrow prompt (=>):

                S 103225-99-6/PRO (A) 75-85/YD

 	 To search for a yield greater than 75% you would enter

                S 103225-99-6/PRO (A) YD>75

 	 Yields are not given for all products in the file.  Therefore, to
 	 include answers that did not have a yield, enter the search in the 

following way:
					       .
					       .
					       .

Since its beginnings, STN has provided 
a variety of assistance designed to make 
your online experience productive.  
This article reviews some of the user aids 
currently available:

•	 HELP command

•	 STNGUIDE

•	 Help files for STN interfaces

•	 Internet resources

•	 CAS Customer Care

HELP command
The STN online HELP command has 
always been available.  Its shortcut is the 
question mark (?).  There are two kinds 
of online help: 

•	 Database-specific HELP

•	 “System” HELP

Database-specific HELP

These help messages relate only to 
a specific database.  Although many 
of the titles are the same in multiple 
databases, the content is database-
specific.  To view the available database-
specific messages, enter HELP 
DIRECTORY at an arrow prompt.  

HELP is at hand!

To view the available database-
specific messages, enter 

HELP DIRECTORY at an arrow 
prompt.  
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Enter HELP MESSAGES or ? MESSAGES at an arrow prompt for system help.

=> ? MESSAGES
Many HELP messages are available to explain files and features of the 
system.  Each command has a separate explanation that can be viewed by 
entering HELP (or ?) followed by the command name at an arrow prompt 

(=>).  
Enter HELP COMMANDS for a list of commands. 

Example: => HELP PRINT

Some commands have detailed help for specific functions for that
command.  At an arrow prompt, enter HELP followed by the command name and 
the specific option:

HELP DISPLAY (ACC, BROWSE, COST, EXPAND, FORMAT, HISTORY, L#,  
              PRINT, QUERY, SAVED, SCAN, SELECT, SET, TOLERANCE, 
              TSORT, UNIT) 

HELP PRINT (ACC, L#, TSORT) 
HELP READ (FOLDER, MAIL, NAMELIST, PUBLIC)
HELP SEARCH (PROJECTIONS, RANGE, STEPS, SUBSET) 
HELP SET (ABBREVIATION, ACCOUNT, AUHELP, AUTOSEARCH, BANNER,  

          CLUSTER, COST, DCLUSTER, DETAIL, DFORMAT, DUPORDER,  
          EXPAND, FAX, FAXC, FAXN, FIELD, FORMAT, GRAPHICS,  
          HEADING, HIGHLIGHTING, INTERPRET, KWIC, LCOST,  
          LINELENGTH, LOGIN, MAILID, NAMELIST, NOTICE, PADDING,  
          PAGELENGTH, PASSWORD, PATENT, PERMANENT, PLURALS,  
          POSTINGS, PRINT, PROXIMITY, RANGE, RELATION, ROLES,

               ROUND, SELORDER, SFIELDS, SMARTSELECT, STATUS, STEPS, 
               SUBSET, TERM, TLANGUAGE, TOLERANCE, UNIT) 
					       .
					       .
					       .

For example, to learn about the system-wide SET CLUSTER command, 
enter ? SET CLUSTER.  

=> ? SET CLUSTER

Use SET CLUSTER to create personal clusters of files that are 
available for searching in a multifile session.  Enter SET CLUSTER at an 
arrow prompt (=>) followed by the name of the cluster you want to create.  
Cluster names must:

  1.  Begin with a period (.) 
  2.  Have 2-16 characters, and 
  3.  Contain only letters A-Z, numbers (0-9), and periods (.). 

You will be prompted to define the cluster.  Enter one or more valid file 
names, user-defined clusters, system-defined clusters, or combinations of 
these.  Separate the names with a space or a comma. For a list of valid 
file names, enter HELP FILE NAMES at an arrow prompt.  For a list of 
clusters, enter DISPLAY CLUSTER at an arrow prompt.  The defined cluster 
is then saved permanently on your login ID. 
					       .
					       .
					       .

“System” HELP 

System help explains commands and 
features that are not database specific, but 
general for many or all STN databases.  

To explore the various system helps, begin 
by entering HELP MESSAGES at an arrow 
prompt  in any database.  An example of a 
system help message about SET CLUSTER 
command is at the bottom of the page.

To explore the various system 
helps, begin by entering HELP 

MESSAGES at an arrow prompt  
in any database. 
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Use STNGUIDE to find databases that contain information on a particular general topic.

=> FILE STNGUIDE
=> S REACTION
        24 REACTION
        23 REACTIONS
L1      30 REACTION
            (REACTION OR REACTIONS)

L1 indicates 30 answers (each a database) with reaction information.  The L-number may 
be displayed in a number of different display formats and fields.  To see the options, enter 
HELP FORMAT and HELP DFIELDS at an arrow prompt in STNGUIDE.

Search for a specific database in the Database Name field (/DBN).

=> S CASREACT/DBN
L1       1 CASREACT/DBN

L2 indicates that there are 30 databases on STN with reaction information.  The L-number 
may be displayed in a number of different display formats and fields.  To see the options, 
enter HELP FORMAT and HELP DFIELDS at an arrow prompt in STNGUIDE.

STNGUIDE 
STNGUIDE contains one record for each 
database on STN.  Each record contains 
the complete Database Summary Sheet, 
pricing information, and additional 
information describing the subject 
coverage of the database.

There are no stop words in STNGUIDE.  

The Basic Index (/BI) contains single words from the following fields:  

	 Field	 Description

	 CC	 Classification Code

	 DBN 	 Database Name Field

	 DFIELD	 Display Fields

	 DESC	 Database Description

	 LA	 Language
	
	 PROD	 Database Producer

	 PROP	 Property Fields

	 SFIELD	 Search Fields

	 SI 	 Source of Information

	 SUBJ	 Subject Coverage

	 SUPP	 Database Supplier

	 TFIELD	 Thesaurus Fields

	 UA	 User Aids
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Help files for STN interfaces
Help files are available to help you use each of the STN interfaces:

 STN interface	 Access by selecting…

 STN Express with Discover!	 Index from the Help menu

 STN AnaVist	 Help on the main menu

 STN on the Web	 About on the left-hand navigation frame

 STN Easy and STN Easy for Intranets	 Help on the left-hand navigation frame

Internet resources 
STN web sites provide a continuously updated selection of user aids, interactive training, 
e-Seminars, Database Summary Sheets, and other documentation and instructional 
materials.  Visit these sites to browse the materials that are available:

www.cas.org/ONLINE/STN/doc.html
www.stn-international.de/training_center/training.html

Additional information about each of the STN interfaces, including examples, is available 
on the product web pages:

 Interface	 Web site

 STN 	 www.cas.org/stn.html

 STN Express with Discover!	 www.cas.org/ONLINE/STN/discover.html

 STN AnaVist	 www.cas.org/stnanavist/

 STN on the Web	 stnweb.cas.org

 STN Easy	 stneasy.cas.org/easy5/

 STN Easy for Intranets	 stneasy.cas.org/html/english/STNEasyIntranets/Intranets.html

CAS Customer Care
In addition to the online and web resources mentioned above, STN provides Help Desks 
at the STN Service Centers and other agencies throughout the world.

In North America, CAS Customer Care is available 8 a.m. - 8 p.m. EST, Monday through 
Friday.  

Phone:	 800-753-4227 (North America) 
  	 614-447-3700 (worldwide) 
Fax:       	614-447-3751
E-mail:   	help@cas.org

STN web sites provide a 
continuously updated selection 

of user aids, interactive 
training, e-Seminars, 

Database Summary Sheets, 
and other documentation and 

instructional materials.
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Pre-order your 2007 CAS Catalog
The 2007 CAS Catalog provides an overview of:

•	 All CAS products and services

•	 CAS database content

•	 STN databases

•	 STN database clusters

•	 STN database producers

•	 CAS Customer Care 
	 contact information
 
•	 And more

Are you interested in receiving a free copy?

To receive a catalog in early 2007, contact CAS Customer Care 
at help@cas.org.  Be sure to include your name and complete 
address with your request.  Also, indicate whether you would like 
to receive the catalog in print or on CD-ROM.

STNews binders available

Need a binder for your 2006 issues of STNews?  Want a binder for 
your 2007 issues?  CAS has STNews binders available.

To request your free binder, contact CAS Customer Care at 
help@cas.org.  Be sure to include your name and complete 
address with your request.

LOGOFF HOLD duration extended 
to 120 minutes
The time limit set for the LOGOFF HOLD command in STN 
has been extended from 60 to 120 minutes.  If you log in 
again, the session will continue from the point of LOGOFF 
HOLD.

Additional information on the LOGOFF HOLD command 
is available at:
www.cas.org/training/stncommands/logoff.html

E-mail formats enhanced 
for PRINTS sent via e-mail 
and for SDI results
The PRINT command in STN can be used to send prints 
(copies) of answers electronically to a specified STNmail ID 
or e-mail address.  

The format for e-mail generated with the PRINT command 
now includes the following additional information:

•	 Number of answers

•	 Database name

The SDI (selective dissemination of information) command 
in STN is used to set up automatic current-awareness 
alerts.  The format for hyperlinked e-mail generated with 
the SDI command now includes the following additional 
information:

•	 Number of answers

•	 Database name

•	 SDI name

•	 SDI run number

•	 SDI run date

Additional information on the PRINT and SDI commands is 
available at:  
www.cas.org/training/stncommands/print.html
www.cas.org/training/stncommands/sdi.html
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STN Express with Discover! 
free maintenance release 
Version 8.01c now available
A free maintenance release (Version 8.01c for Windows®) is now 
available for STN Express with Discover!  This release is available 
to current users of STN Express with Discover!, Version 8.0 
or higher for Windows.

The maintenance release includes enhancements and fixes 
to specific issues that have been reported, including:

•	 The Report and Table post-processing tools have been 
updated to accommodate new fields available in the recently 
reloaded Derwent World Patents Index (DWPI) database suite.  
To apply post-processing tools to these new records, it is 
critical that you upgrade to Version 8.01c.  

•	 To reduce login time, the STN splash screen has been removed 
from the login process.  

•	 The CA Lexicon and Company Name Thesaurus have been 
reloaded.

•	 Acyclic bond characteristics set to Ring no longer revert to 
Chain.  

Software availability

To upgrade to this maintenance release from an existing version 
of the Analysis Edition (Version 8.0 and higher): 

1.	 Launch STN Express.
2.	 Select Web from the toolbar.
3.	 Select the appropriate STN Service Center.
4.	 Select Free Maintenance Upgrades.

Or, for instructions on how to download this maintenance release, 
visit:
www.cas.org/Support/express80/win/patches/patches.html

You need to currently have the Analysis Edition of STN Express 
with Discover!, Version 8.0 or higher, to download this free 
maintenance release.  To verify the version you are using:

1.	 Launch STN Express.
2.	 Select Help > About STN Express from the main menu.

For STN-Columbus customers with an STN login ID and 
password, STN Express with Discover!, Version 8.01c, will also be 
available directly from the Web via the Purchase and Download 
site (casweb.cas.org/stnexpress/html/english/login.html).

You can also obtain the software on CD-ROM:

•	 Use the printed or PDF version of the STN Express with 
Discover! Order Form.

•	 Request a CD-ROM online.

CAS Registry Number crossover 
limit increased to 300,000 
in multiple databases
The crossover limit for CAS Registry Numbers 
has increased in 30 databases on STN.

Increased from 0 to 300,000:

•	 LCASREACTSM

Increased from 10,000 to 300,000:

•	 ADISINSIGHT	 •  IPA

•	 ADISNEWS	 •  JICST-EPLUS

•	 AGRICOLA	 •  MEDLINE

•	 AQUIRE	 •  LMEDLINE

•	 BIOSIS	 •  PROMT

•	 CABA	 •  PROUSDDR

•	 EMBASE	 •  SYNTHLINE

•	 LEMBASE	 •  TULSA

•	 IMSCOSEARCH	 •  TULSA2

•	 IMSPATENTS	 •  USPATFULL

•	 IMSRESEARCH	 •  USPAT2

Increased from 20,000 to 300,000:

•	 GENBANK®

Increased from 30,000 to 300,000:

•	 CASREACT®

•	 CHEMCATS

•	 CHEMLIST

•	 HCHEMLIST

•	 MSDS-OHS

Increased from 50,000 to 300,000:

•	 TOXCENTER

There is a charge for the crossover of each CAS Registry 
Number into non-CAS databases.  Enter HELP COST 
in the CAS REGISTRY database for details.
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2006 STN instructor-led seminars
www.cas.org/training/schedule.html

Albany, NY
12/5	 9:00 a.m.-12:00 p.m.	 CAplus Subject Search 

Techniques
12/5	 1:00 p.m.-4:00 p.m.	 Basic Substance Search 

Techniques
12/6	 9:00 a.m.-12:00 p.m.	 Basic Patent Search Techniques
12/6	 1:00 p.m.-4:00 p.m.	 Patent Family and Legal Status 

Search Techniques
12/7	 9:00 a.m.-12:00 p.m.	 STN User Update
12/7	 1:00 p.m.-4:00 p.m.	 STN Express with Discover!, 	
		  Version 8.01, and STN AnaVist –
		  Advanced Tips and Tricks

San Francisco, CA
1/16	 9:00 a.m.-12:00 p.m.	 STN User Update
1/16	 1:00 p.m.-4:00 p.m.	 STN Express with Discover!, 	
		  Version 8.01, and STN AnaVist –
		  Advanced Tips and Tricks
1/17	 9:00 a.m.-12:00 p.m.	 CAplus Subject Search 		
		  Techniques
1/17	 1:00 p.m.-4:00 p.m.	 Basic Substance Search 		
		  Techniques
1/18	 9:00 a.m.-4:00 p.m.	 Markush Searching in the Patent 	
		  Literature

San Diego, CA
1/30	 9:00 a.m.-12:00 p.m.	 STN User Update
1/30	 1:00 p.m.-4:00 p.m.	 STN Express with Discover!, 	
		  Version 8.01, and STN AnaVist – 
		  Advanced Tips and Tricks
1/31	 9:00 a.m.-12:00 p.m.	 CAplus Subject Search 		
		  Techniques
1/31	 1:00 p.m.-4:00 p.m.	 Basic Substance Search 		
		  Techniques

All STN instructor-led seminars in North America are free, 
but registration is required.

For descriptions or to register, visit:
www.cas.org/training/regform.html

2006 FIZ Karlsruhe e-Seminars
12/7	 9:00-10:00 a.m.	 Retrieving EP Register Data on STN
12/12	 9:00-10:00 a.m.	 Beilstein on STN – Basics

All times are U.S. Eastern Standard Time.

For descriptions, visit:
www.stn-international.de/training_center/e_sem/e_desc.html#bos

2006 FIZ instructor-led seminars
www.stn-international.com/training_center/
workshops/derwent_ws.html

Derwent World Patents Index (DWPI) on STN workshops

You are invited to attend free DWPI on STN workshops in the 
U.S., presented by FIZ Karlsruhe.

Boston, MA
12/12	 9:00 a.m.-12:00 p.m.	 Introduction to Derwent World 	
		  Patents Index on STN
12/12	 1:00 p.m.-4:30 p.m.	 Derwent World Patents Index 
		  on STN: Reloaded & Beyond
12/13	 9:00 a.m.-12:00 p.m.	 GENESEQ on STN (DGENE)
12/13	 1:00 p.m.-4:30 p.m.	 DWPI for Competitive Intelligence 
		  on STN

Washington, DC
12/20	 9:00 a.m.-12:00 p.m.	 Introduction to Derwent World 	
		  Patents Index on STN
12/20	 1:00 p.m.-4:30 p.m.	 Derwent World Patents Index 
		  on STN: Reloaded & Beyond
12/21	 9:00 a.m.-12:00 p.m.	 GENESEQ on STN (DGENE)
12/21	 1:00 p.m.-4:30 p.m.	 DWPI for Competitive Intelligence 
		  on STN

All FIZ instructor-led seminars are free, but registration is 
required.
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Previously recorded CAS e-Seminars 
and tutorials available
https://casevents.webex.com
Previously recorded CAS e-Seminars and tutorials are:

STN AnaVist
•	 Creating Result Sets for Use in STN AnaVist 
•	 Going Beyond Basic Navigation on STN AnaVist 
•	 STN:  Introduction to STN AnaVist
•	 Using the Custom Grouping Capabilities in STN AnaVist
•	 Using the STN AnaVist Interactive Visualization Workspace

STN Express with Discover! 
•	 STN:  Post-Processing Search Results with the Analysis Edition 

of STN Express with Discover!
•	 STN:  Using Discover! Wizards in STN Express
•	 STN:  Visualization Tools in STN Express with Discover!, 

Analysis Edition (Version 7.01) 
•	 STN:  What’s New with STN Express®?

Structure Techniques
•	 STN:  Advanced MARPAT Techniques
•	 STN:  All About MARPAT
•	 STN:  Finding Post-Treated and Blended Polymers
•	 STN:  Introduction to Polymers 
•	 STN:  Reaction Searching 
•	 STN:  Advanced Structure Search Techniques, Ring Information 
•	 STN:  Advanced Structure Searching with Filters/Screens
•	 STN:  Organometallics and Coordination Compounds
•	 STN:  Stereochemistry in the CAS REGISTRY File 
•	 STN:  Structure and Substructure Searching Tips
•	 STN:  Using Boolean Operators in Structure Searching 

Patent Searching
•	 STN:  Biotech Patent Validity Tips
•	 STN:  Biotextology Text Search Techniques 
	 for Biological Information
•	 STN:  Capitalizing on IPC Reform
•	 STN:  Expanding Your Prior Art Search with Controlled 

Terminology
•	 STN:  Highlights from the NE Regional PIUG Patent Forum
•	 STN:  Improving Searches by Including Patent Classification 

Codes
•	 STN:  Increasing Confidence in Search Results
•	 STN:  Is That Patent Still Valid?  Finding Patent Expirations 
	 and Extentions
•	 STN:  Multifile Patent Searching
•	 STN:  Patent Citation Searching
•	 STN:  Searching for Patent Families

Miscellaneous
•	 STN:  Automating Your Search 
•	 STN:  Finding Antibodies & Immunoglobulins
•	 STN:  Finding Clinical Trial and Drug Pipeline Information
•	 STN:  Finding Regulatory Compliance Information in 

CHEMLIST®

•	 STN:  Finding Regulatory Information 
•	 STN:  Have It Your Way – Customizing Your STN Account
•	 STN:  Maximizing Your STN Fixed Fee Plan
•	 STN:  Multiple Methods of Keeping Current
•	 STN:  Property Searching in CAS REGISTRY
•	 STN:  Searching for Engineering Information
•	 STN:  Strategies for Finding Novel Formulations
•	 STN:  Text Searching in CAS REGISTRY
•	 STN:  Using the Cambridge Scientific Abstracts (CSA) Files

2006-2007 CAS e-Seminars
www.cas.org/training/schedule.html

12/14	 9:00-10:00 a.m.	 STN: Multifile Structure 		
			   Searching for Patent Information 	
			   (rebroadcast)

12/19	 1:00-2:00 p.m.	 STN: Processing Sequence Data

1/11	 9:00-10:00 a.m.	 STN: Processing Sequence Data 	
			   (rebroadcast)

All times are U.S. Eastern Time.

For a description or to register, visit:
https://casevents.webex.com/

STNewsline—did you sign up?
STNewsline, our electronic newsletter, is published every 
month.  Are you receiving it?

You are not automatically signed up to receive STNewsline just 
because you receive STNews.  We need your e-mail address 
to send it to you.

To receive the latest news about STN by e-mail, visit: 
www.cas.org/STNEWS/signup.html

Or, complete this form and fax it to: STNews Editor, 
614-447-3837.

❑  YES!  Sign me up to receive STNewsline:

 NAME

 E-MAIL ADDRESS

 ORGANIZATION

 COUNTRY



	 	 	 	
	 	 	 	In case you missed it:

STNews Jul/Aug
•	 STN’s mission to serve 
	 with unparalleled content, 
	 powerful tools, and expert 
	 service

•	 Enhancing your search results                 	
	 with SELECT CHEM

•	 Finding salts in MARPAT

•	 Finding related company names 
	 in CA/CAplus

•	 Customize predefined reports 
	 by editing the default format 
	 in STN Express with Discover!

•	 Finding and using F-Term 
	 patent classifications

STNews Sep/Oct
•	 STN AnaVist—Visualizing
	 results from a variety
	 of databases

•	 DWPI reloaded and enhanced

•	 Take care when including 
	 hydrogen in G-groups

•	 STN aliases make searching
	 more convenient

•	 Getting smart about SLART

You can find it easily by searching 
the CAS web site at:  
www.cas.org/websearch.html
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